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Eclipse is an Integrated Developed Environment (IDE). You can use Eclipse to design,
develop, test and deploy many different types of applications in many languages. We are
going to use Eclipse to develop Java applications. This document describes how to
install and configure Eclipse on XP. Linux, Solaris and Macintosh users should be able to
use these directions as a guide.
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Installing Java

Java 1.5 SE or higher is required. Java 1.5 SE is equivalent to Java 5.0 SE. The same
pattern applies to Java 1.6.

Step 1: Go to your Control Panel and click on the Java icon. If there is no Java Icon java
is probably not installed. If you are using a computer that has applications requiring
specific versions of Java less than 1.5, you will have to install two versions. If you don’t
need the existing version and it is less than 1.5, you can remove it. You remove programs
by going to the Control Panel and Using the Add/Remove widget.
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B Control Panel : §| |Z|
.r'f

File Edit ‘jew Favorites Tools Help

l.ﬁ f_ﬁ] Search [i__-__ Folders | =0 2 x g v

X D W 8 P &

Accessibility  Add Hardware Add or Administrative  Automatic Date and Time Display
COptions Remow, .. Tools Updates

2 v @ £ = O

Folder Options Fonks Game Inkernet Java Kevboard rail
Controllers Cptions

@ % L & % &

Metwaork,  Metwork Setup Phone and  Porkable Media Power Options — Printers and
Conneckions Wizard Modern ... Devices Faxes

e 3 2 0 9 ¥

QuickTime  Reqgional and  Scanners and  Scheduled Security Sounds and Speech
Language ... Cameras Tasks Cenker Audin Devices

A e e o @

Taskbar and  User Accounts  Windows Wireless YAMAHA
Start Menu Firewall Metwork, Set...  1JSE-M...

Step 2: Check the version number.
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£ Java Control Panel

zeneral |LI|:u:Iate Java | Security | Advanced

Ahauk

Wiew version information about 1ava Contral Panel,

Metwork Setkings

Metwork settings are used when making Internet connections. By default, Java
will use the nebwork setkings in your web browser, Only advanced users should
modify these settings,

Metwork Settings. ..

Temporary Internet Files

Files wou use in lava applications are stored in a special folder for quick execution
laker. Only advanced users should delete files or modify these settings,

[ Delete Files. .. H Settings. .. ]

[ o] 4 H Cancel ]

Step 3: You should see something like this:

About Java

S Sun

micrasystems

JAVA™ 2 Platform
Standard Edition

Werzion 1.5.0 (build 1.5.0_l0-b03)
Copyright 2006 5un Microsystems, Inc.

411 rights reserwved. Use is subject to license terms.

For more information about Java technology and to
explore great Jawva applications, vizit
http: /fimnr. Java. com

Close

Step 4: If you need to install Java go to the location where the Java SDK is located.

Create Commons License Pace University



8/21/2007 4
DPS2010 Eclipse IDE install Revision 0.2

& C:\DPS2010 FEX
File Edit ‘Wiew Fawaorites Tools  Help i';'

M_F," \_/l lﬁ 1II“"I.__“JSE.an:h - Folders |'$ (¥ x n ,

Marme Size  Type Date Modified
| subclipse-1.2.3 File Folder G121)2007 9:13 AM
1] eclipse-java-europa-win3z 80,586 KB Compressed (zippe...  8/21/2007 7:53 oM
@ jdk-1_5_0-doc 45,109 KE  Compressed (zippe...  8/22/2007 7:44 AM
P junit4. 4 TISKE Compressed (zippe...  8/22/2007 7:51 AM
jdk-1 5 . 52,560 KE  Application 8/22/2007 7:53 AM

Description: Setup Launcher
Company: Sun Microsystems, Inc,
File Wersion: §.3.165.0

Date Created: 8/22/2007 7149 &M
Size! 51,3 MB

Step 5: Agree to the License terms and click next.

i@ J2SE Dewvelopment Kit 5.0 Update 12 - License

License Agreement

Please read the following license agreement carefully,

=un Microzystems, Inc. Binary Code License Agreement

8] 3

for the JANA 2 PLATFORM STAMDARD ECITICON DEVELOPMEMT KIT 5.0

SUM MICROSYSTEMS, INC. ("SUN") 15 WWILLING TO LICEMSE THE SOFTWARE IDEMTIFIED

BELCWY TO QU QLY UPOKN THE COMDITION THAT YOU ACCEPT ALL OF THE TERMS
COMTAIMED IM THIS BINARY CODE LICEMSE AGREERMENMT AMD SUPPLEMENTAL LICEMSE

TERMS (COLLECTAELY "AGREEMEMT"). PLEASE READ THE AGREEMEMT CAREFULLY. BY
DOAMLOADIMG OR INSTALLIMNG THIS SOFTWARE, YOU ACCEPT THE TERMS OF THE
AGREEMEMNT. IMDICATE ACCEPTAMCE B SELECTING THE "ACCEPT" BUTTOMN AT THE

BOTTOM OF THE AGREEMENT. IF YO ARE MOT WALLING TO BE BOUMD BY ALL THE TERMS,
SELECT THE "DECLINE" BUTTOMN AT THE BOTTOM OF THE AGREEMEMT AMD THE W

{(#)1 accept the berms in kthe license agreement;

{1 do not accept the terms in the license agreement

[ Mext = ] [ Cancel ]

Step 6: Take the defaults and click next, make a note of the install to directory. Windows
likes to put things in “Program Files”. In this case C:\Program Files\Java\jdk1.5.0_12
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iG J2SE Development Kit 5.0/ Update 12 - Custom Setup

Custom Setup

Seleck the program Feaktures you wank installed.

Select optional features to install from the list below, You can change wour choice of Features after
installation by using the AddfRemove Programs ukility in the Conkral Panel

Feature Description
groveeees E'E"."Ell:ll:lrl-lerlt T|:||:||5 J25E DEVE'meEnt Kik 5.':'_.
: inchuding private JRE 5.0, This

Demos will require 264 MEB on your hard
Source Code ke,

Public JRE

Install ba
Ci\Program Files)Javaijdkl.5.0_12),
Installshield

[ = Back ]L Mesk = ] [ Cancel ]

Step 7: Click Finish, if you installed this as the only version of Java, you should be able
to find it by using the Control Panel Java Wizard, like you did in Step 1:

i& J2SE Development Kit 5.0 Update 12 - Complete

Installation Completed

The Install Wizard has successfully installed 123E Development
kit 5,0 Update 12, Click Finish to exit the wizard,

= Back Firish Cancel
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Installing Eclipse

Step 1: Navigate to the directory with the eclipse zip file. Right click on the file name
below and then select Extract All. The zip file can be found on the CD/DVD/USB device
or hard disk, for online download see Appendix A
& C:\DPS2010 EX
File Edit ‘Wiew Faworites  Tools  Help {.r'

\_JJ _./I I'j: jﬂ] Search i Folders |$ L}? x g v

Size  Type Date Modified
15| eclipse-java-suropa-win3z 30,586 KB Compressed (Zippe...  8/21/2007 7:53 oM

Step 2: You should see the following.
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Welcome to the

Wizard

from inzide a ZIF archive.

To continue, click MNext,

Compressed (zipped)
Folders Extraction

The extraction wizard helps you copy files

X]

MEHI: >

| [ Cancel

Step 3: Extract the files into C:\eclipse

Extraction Wizard
Select a Destination

chooze.

Filez inzide the ZIP archive will be extracted to the location pou

Select a folder ta extract files to.

Filez will be extracted to this direchany:

Checlipze

Extracting...

Pazzword...

[

J

[ ¢ Back ” MHewt >

l [ Cancel ]
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Step 4: When the extraction completes click finish and navigate to the directory where
the files were extracted. Verify that you have the following version of JUnit. 4.3.1. You
should see something like the screen below. JUnit will not be highlighted.

= C:\eclipseleclipselplugins E] [E| E|
'll

File W=l8 Yiew Fawaorites Tools  Help i}

£ > 'ﬁ‘ /.. ) sgarch Folders |:H$ .js‘ x u’ EIT

Marme Size  Type Date Modified b
[horg.apache.ant_1.7.0.v2007... File Folder 8121)2007 §:01 AM
[ org.eclipse. core.runtime, com. .. File Folder 8121)2007 §:01 AM
[horg.eclipse. equinox.launcher. . .. File Falder 3121)2007 §:01 AM
[Zhorg.edipse.jdt. debug_3.3.0.... File Folder 8/21/2007 3:02 aM
|Chorg.edipse, platfarm_3.3.0,%2... File Folder 8/21/2007 3:02 aM
[Chorg.edipse.tomcat_4.1,230,v,., File Folder g/21/2007 3:02 aM
[horg.edipse.ui.intra.universal .. File Folder 8121)2007 §:02 AM
[ org.eclipse, ui.workbench.com. .. File Folder 8121)2007 §:02 AM
[horg.eclipse, wsk.command.envy. .. File Folder 8121)2007 §:02 AM
I8l org. junitd_4.3.1 File Folder 8121)2007 §:02 AM
) org.junit_3.8.2.v200706111738 File Folder 58/21/2007 5:02 AM
com.ibrm.icu_3.6.1.+20070417 3,977 KB Executable Jar File 6/28/2007 9:14 PM
com.jeraft.jsch_0.1.31 177 KB Executable Jar File 6/28/2007 9:14 PM
javax,serviet,jsp_2.0.0,v200... 62 KB Executable Jar File 6/28/2007 9:14 PM
javax,serviet _Z2.4.0,v200706, .. 106 KB Executable Jar File 625812007 914 PM
arg.apache.commons.el_1.0.... 125 KB Executable Jar File Bf252007 9:14 PM
arg,apache.commons. logging. .. 43 KB Executable Jar File 6252007 9:14 PM
arg.apache.jasper_5.5.17 .%2... 1,681 KB Executable Jar File BI28)2007 9:14 PM
arg.apache.lucene analysis_1... AIKE Executable Jar File Bf28)2007 9:14 PM L

Step 5: Navigate to the following directory and launce eclipse. Optionally pin Eclipse to
your start menu. You can do this by right clicking when you have the mouse over the
eclipse executable.
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& C:lecli pseleclipse |Z| |E|

File Edit  ‘iew Faworites  Tools  Help

\_J:' \_/I lﬁ /.._\] Search i Faolders |'$ I.j?' x n v

X
'1:

Marne Size  Type Dake Maodified
[ configuration File Folder 312112007 S:01 AM
[Cifeatures File Folder 8/21/2007 3:01 AM
[Ciplugins File Folder 12112007 5:02 AM
[Chreadme File Folder 312112007 3:01 AM
.eclipseproduct 1 KB ECLIPSEFRODUCT File  6/28/2007 9:14 FM
[ ]eclipse 52 KE  Application 6/Z8/2007 9:14 PM
?‘}eclipse 1 KB Configuration Settings  7/2/2007 10:09 AR
Eeclipsec 23 KB Application GIZEIZ007 9:14 PM
@epl-vlﬂ 17 KB  Firefox Document 6/28/2007 9:14 PM
\_Bﬂ natice 7EE Firefox Document BIZEIZ007 9:14 PM

Step 6: Launch eclipse, advanced users can change the location for your workspaces.

& Workspace Launcher r5_<|

Select a workspace

Eclipse Platform stores wour projects in a folder called a workspace,
Chonse a warkspace Folder ko use Far this sessian,

Workspace: | Z:\Documents and SeftingsiRinaldalworkspace

[ Juse this as the default and do nok ask again

[ (9] 4 l [ Cancel

Step 7: You should see something like the following
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& Java - Eclipse Platform
File Edit Mavigate Search Project Run  Window Help

Welcome 23

-~ |zg =

"
Workbench G0 ko the workh
Go to the workbench

Step 8: Click the Workbench icon above and verify that you see the following.
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& Java - Eclipse Platform

File Edit Source Refactor Mavigate Search Project Run  Window Help

i H-0- Q- I BHEHEG- I GS A S (& 202 |
[# Package Explor &3 'Eg Higrarchy | — O = B || B TaskList 2 =08
BES @7 d@E- &7
Fnd: [ ] raly

[ Uncategorized

5= outline 52 =0

An outline is not available.

[2l Problems 22 @ Javadoc @;.Declaration e T 0O
0 errors, 0 warnings, 0 infos
Drescription Resource Path Location
oo : e O F e

This completes the installation of the Eclipse IDE. Eclipse is enhanced by the use of
plugins. We are going to install and or enable several additional plugins.

Adding Subversion Support

We are going to use the subclipse plug-in from http://subclipse.tigris.org/ to install the
plug-in follow the directions here:

http://subclipse.tigris.org/install.html

Step 1: Go to the Help menu item in the Eclipse IDE, you installed above
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3

-I:Iﬁ

Window Help
¥ J é £ Welcome i | &3ava
Help Contents = )
(@ Help 5= Qutline 3 |
Tips and Tricks... I . y
An outline is not available.
Cheat Sheets. ..

Software Updates ¥ &7 Find and Install...

About Edipse Platform &3 Manage Configuration...

Step 2: Select Search for new, click next.

12

B Install/Update

Feature Updates
Choose the way you want to search for features to install

™ Search for updates of the currently installed features
' Search for new features to install

% = Back I Mext = I

Fimish

Cancel

Step 3: Press “New Local Site”
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13

& Install

Update sites to visit

Select update sites ko visit while looking For new Features.

Sites ko include in search;

- O]

'\h D@

O 9:] Eclipse Modeling Framework (EMF) Updates

] *u Eclipse Modeling Framework Technologies (EMFT) Updates
|:| 9:] Europa Discavery Site

] *}u Maodel Developement Tools (MDT) Updates

] *ﬂ The Eclipse Project Updates

[] | web Tools Platform (WTF) Updates

[ Mew Remoke Site... ]

[ Hew Local Site... |

[New Archived Site. .. ]

[ Impork sites. .. ]

[ Export sites. .. ]

Ignore features not applicable to this environment:

[ ]automatically select mirrars

®

Cancel

Step 4: Navigate to the location of the following file in the CD or hard disk if you copied

it over.
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Browse For Folder

Select a local update site.

I3 20gb 2005 backups
I3 Cakewalk Projects
[ Config. Msi
=) cygwin
[=) DELL
|5 Documents and Settings T
= 153 DPsz010

[

subclipse-1.2.3

I Features

I3 plugins
=) eclipse

(54

Falder: | subclipse-1.2.3 |

[ Make Mew Folder ] [ (0] 4 l [ Cancel ]

Step 5: You should see the following, click ok.

£ Edit Local Site X

Mame: | SPS2010/subclipse-1.2.3

X

IIRL: | File: )2 JDPS2010fsubclipse-1.2.3)

7 [ QK H Cancel ]

Step 6: Click “Finish” On this Screen.
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Update sites to visit
NI
Select update sites ko visit while looking For new Features. "

Sites ko include in search;

] DPs2010fsubclipse-1.2.3 | Hew Remote Site... |
] *u Eclipse Modeling Framework (EMF) Updates : _ :
] 9:] Eclipse Modeling Framework Technologies (EMFT) Updates | Mew Local Site. . |

|:| *}u Europa Discavery Site

] *ﬂ Maodel Developement Tools (MDT) Updates
] 9{] The Eclipse Project Updates

[] ] web Tools Platform (WTF) Updates

[New Archived Site. .. ]

[ Impork sites. .. ]

[ Export sites. .. ]

Ignore features not applicable to this environment:

[ ]automatically select mirrars

@ Einish l [ Cancel

Step 7: Unselect Integrations (Optional) and click Next
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& Updates |:| @

Search Results
NI
Select Features ko install From the search result lisk, " —
)
i
Select the Features ko install:

= |E|¢:| DPSz2010/subclipse-1.2.3 Deselect all

=-[J000 Inkeqgrations {Optional)
[[]4* Subclipse Integration far Mylyn (Optional) 2.0,0 Mare Info
[+]000 Subclipse Plugin

Properties

Select Required

Error Details, .

Eclipse Install/Update site for Subclipse

1 af 2 selected.
Shows the lakest version of a Feature anly

] Filker features included in okher Features on the list

i’
]
'\.\12

< Back Mext > Einish

Step 8: Accept the Apache License terms.
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Feature License

Some af the features have license agreements that you need to accepk before proceeding with the ¥ —
installakion, Dl
h
@Subclipse 1.2.3 Subclipse Software User Agreement A

11th April, 2006

Subclipse is icensed under the kerms of the Eclipse Public
License w1.0, htkpe v, eclipse,argflegalfepl-w 10, Rkl

Applicable Licenses

Subclipse is built upon a number of other open source
technologies and producks, Here is a lisk of those producks
with links ko their licenses,

synClientadapter: Part of the overall Subclipse project,
svni_lientAdapter presents a pluggable high-level interface
ko the Subversion repositary,  synClientAdapter is licensed
under the Apachez? License,

http: /fvmva, apache. orglicenses/LICENSE-2.0

Depending on the adapter vou choose in your preferences, the

(31 accept the kerms in the license agreementt

)1 do not accept the terms in the license agreement

':':’:' < Back ” Mext >

Step 9: Click Finish
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& Install

Installation

NI

The following Features will be installed, ¥ou can select a feature and change the location where the " —
feature will be installed, .\_-J)

Features to inskall;

Feature Marme Feature Yersion Feature Size Installation Direckary
@Suhclipse 1.2.3 LInkmown 1Tl edipse/eclipsef
Install Lacation:  Cileclipseleclipse Change Location ...

Required space: Unknown
Free space: 3.51 GB

Einish l [ Cancel

Step 10: Click Install All
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Feature Yerification

NI
L

15 WWarning: You are about toinstall an unsigned Feature, ¥ —
Y¥ou may choose to install the Feature or cancel its installation, \:‘Dl

This Feature has not been digitally signed.
The provider of this Feature cannaot be verified,

Feature name: Subclipse
Feature Identifier: org.tigris.subyersion.subclipse_1.2.3
Prowider: tigris.org

File Identifier; org.tigris.subversion.subclipse_1.2.3

@ Inistall H Install Al ]uancel |

Step 11: Select Yes, Eclipse will restart.

& Install/Update E|

It is recommended wou restark the Eclipse Platform for the changes to take
L. effect, but it may be possible to apply the changes to the current
configuration without restarting. Would vou like to restart now?

| Yes | [ Mo ] [.ﬁ.ppl';.f Changes

Configure JUnit

Step 1: In the Package Explorer view, select your project and right click go to properties,
the last item in the Menu. Your Project Name will be different.
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& Java - VerifyJunit/src/JUNitTest. java - Eclipse Platform

Fle Edi Source Refactor Mavigate Search Project Run Window Help

: [~ H-0-Q- BHG MBS Y | & 1av
[ package Explor 52 'Eg Hisrarchy | = O || 1] JUnitTest java 53 =0 E| Task List &7
i BE @7 g

public class JUNitTest |

Find:

B public JUNitTest() { [ Uncateg
i,
¥ J¢ TOD0 Auto-generated constructor stub

= ll."*'ﬂ‘

* [@param args

wf
= public static void wain(3tring[] args) | -
i, = .
¥l /¢ TOD0 Auto-generated method stub o= Outline &2
} ¢ %R
= O, 1T
o 1
' o
@7 mai
B_\ Problems | @ Javadac @)Declaration |'§|_j History @SVN Repositary &4 q§h

P WeriFyJunit

Step 2: Select the Java Build Path and the Libraries tab. The window should look like
this.
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& Properties for VerifyJunit |:|E]

z | Java Build Path
Resource ————
Builders (% source | 1= Projects | B Libraries | ¥ order and Export
Java Build Path JaRs and class Folders on the build path:
Java Code Style ; ) :
JRE Zyskem Lib 1.5.0_10
Java Compiler i ystem Library [irel,5.0_10] [ Add JARs ]
Java Editor [ Add External J8Rs. .. ]
Javador Location
Project References [ add Variable. .. ]
Run/Debug Settings
Task Repository [ Add Library. .. ]
Task Tags
validation [ add Class Faolder.,. ]
Edit. ..
Remove
Migrate JAR File...
':':’:' (04 l [ Cancel

Step 3: Select Add Library and select JUnit
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& Add Library

Add Library

o
Select the library bype to add,

JRE Sistem Lil:urari

ser Library

Step 4: Select JUnit 4, then Finish.
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& Add Library H{=1/E3
JuUnit Library
Select the JUnit version to use in this project. ﬁ \

JUnit library wersion: | w |

Current location: Checlipseleclipse\pluginsiorg. junitd 4.3, 1\junit. jar

'i':’:' [ Finish l [ Cancel

Step 5: Your Window should look like this.
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& Properties for VerifyJunit

|t*;.-'|:le filker text | Java Build Path
Resource . :
Builders (% source | 1= Projects | B Libraries | ¥ order and Export
Java Build Path JaRs and class Folders on the build path:
+-1 Code Sty r
#-Java Code Style =, IRE Svstem Library [jrel.5.0_10] | addiems.. |
Java Compiler ; ’ =
ava Editor [ fdd External JaRs. ., ]
Javador Location
Project References [ add Variable. .. ]
Run/Debug Settings
Task Repository [ Add Library... ]
Task Tags
validation [ add Class Faolder.,. ]
[ Edi... |
[ Remove ]
{?} Ik l [ Cancel

JUnit 4 has been enabled for the project you selected.

Adding Coverlipse support

The eclipse update site is located at http://coverlipse.sf.net/update. When using the update
site mechanism you don't need to remove older Coverlipse versions. Eclipse will disable
them and only use the newest one.

Step-by-step instructions:
» In Eclipse, click Help -> Software Updates -> Find and Install.
+ Inthe dialog, select Search for new features to install, then Next.

« In the next step, add a New Remote Site. Name it "Coverlipse update site", the
URL is "http://coverlipse.sf.net/update/".

Create Commons License Pace University



8/21/2007 25
DPS2010 Eclipse IDE install Revision 0.2

+  Press Finish. Eclipse now searches for the Coverlipse feature to install and shows
that to you.

In the future, you can use Help -> Software Updates -> Manage Configuration to scan
specifically for Coverlipse updates.

Appendix A

or downloaded from the eclipse website. http://www.eclipse.org/downloads/. We are
using the Eclipse IDE for Java developers. Download the version for your Operating
System.

) Eclipse Downloads - Mozilla Firefox

File  Edit Wiew History Bookmarks Tools  Help

<:F_| - - @ “G} |u hitkp: v eclipse, orgfdownloads) |Y| [

|:| Customize Links |:| Free Hotmail |:| Windows Media El Windows

eclipse

OowMLOADS

HOME RESOURCES FROJECTS ABOUT IS

COMMUNITY MEMEERSHIF

COMMITTERS

Committers

NS Eclipse Downloads

Bugs . . .

. To download Eclipse, select a package below or choose one of the third party Eclipse

Articles distros. You will need a Java runtime environment (JRE) to use Eclipse {Java 5 JRE
recommended}. All downloads are provided under the terms and conditions of the

Downloads Home Eclipse Foundation Software User Agreement unless otherwise specified.

By project

By topic

Source code Eclipse Europa Packages

Eclipse IDE for Java Developers - Windows (73 MB)

The eszertial tools for any Java developer, including a Java IDE, a Cv'E client, XML Editar and kyivn.
Find out more...

Eclipse IDE for Java EE Developers - Windows (125 MB)

Toals for Java developers creating JEE and 'Wekb applications, including a Javwa IDE, tools far JEE and JSF, hWylyn
and others. Find out more...

 JEE

~—  Eclipse IDE for CIC++ Developers - Windows (62 ME)
Q Ar IDE for ChAZ++ developers. Find out more...
-&=

JQ,

Eclipse for RCPIPlug-in Developers - Windaows (153 ME)

A complete set of tools for developers who want to create Eclipse plug-ins or Rich Client Applications.
includes a complete SDK, developer tools and source code. Find out more...

Eclipse Classic - Windows (140 MB)
The clazsic Eclipse dovwnload: the Eclipse Plstfo

= 4 il ol ol Loyl ol

rm, Java Developmert Tools, and Plug-in Developmernt
A,

ok Einnel s

Dione
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Appendix B

The Eclipse IDE tries to help you by suggesting completion while you type. This facility
requires that there are java docs for the classes you are using. Eclipse often points to a
network location. If you would like to replace the reference with something local on your
hard disk so you can work off the network. You have two options for using the files
locally:
1. Copy the directories jdk-1_5_0-doc and junit4.4-doc to your hard disk and point
to them where needed, see directions below.
2. Unzip the Java Docs for Java and for JUnit into a directory of your choosing and
change the reference to point to the root of the directory of the documentation.
You will have to do some searching in the directory tree.
The CD/DVD/USB device contains the docs in zipped format. To get to the
configuration screen, right click on JUnit4 and then select Build Path -> Configure Build
Path

& Java - VerifyJunit/srcitest. java - Eclipse Platform

File Ma[® Source Refactor Mavigate Search Project Run Window  Help
i Ti- [E] Al V R T EHE @O e | & ava |
: o o~
[% Package Explor ©3 'E: Hierarchy | = 5 || [J] JUnitTest.java [3] *test.java 52 =0y
=
S-S 2
== VerifyJunit Fimport org.junit.lifter;[] EI
-2 src |
=8 (defaulk package) 7o 5
[J] JUniTest java . e
[J] test.java "f* ) ==
B IRE System Lbrary [jrel.5.0_12] N Binalde
b ILinit 4
"
public class test §
III.’ T
* Java. lang.Exception
=
fEeforeClass
public static void setUpBeforeClass() throws Exc
H
ll." &
* Java. lang. Exception "
< >
[21 Problem | @ Javado &2 @) Declarat | &) Histary Flavure B consale| = 8
Serify Junitfsec o
o JUnit 4 - Werify Junit
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The Java doc for JUnit below is external; change that to point to the internal location.

& Properties for, VerifyJunit

|type filker kext

Resource

Builders

Java Build Path
Jawa Code Style
Jawa Conpiler
Java Editor
Javadoc Location
Project References
RunyDebug Settings
Task Repository
Task Tags
Yalidation

[ B

Java Build Path

[ Source | 1=+ Projects | B Libraries |'&4} Order and Export

B (=6

JARs and class folders on the build path:

=B JUnit 4

=4\, JRE System Library [rel.5.0_12]

EE': Access rules: Mo rules defined
.‘?‘5 Mative library location: (Mone)
=] EI jurit.jar - Cedipseleclipsetpluginstorg. junit4_4.3.1
@ Source attachment: {Mone) - non modifiable
@ Javadoc location; btk o, junit, org)junit

#dd JA4Rs. ..
Add External J8Rs. ..
Add Yariable, .,
Add Library. ..

Add Class Falder. ..

[igrate JAR File...

o8 H Cancel ]

The Java Doc locations for Java require that you repeat the change of the location several

times once for each jar listed below.
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& Properties for VerifyJunit E]

type filker bexk Java Build Path

Resource —

Builders [ source | = Projects | B Libraries | % Order and Export

Java Build Path 14Rs and class Folders on the build path:

Java Code Style
Java Compiler Bl 00

Javadoc Location = ) ) )

Project References =g rt.jar - CAProgram Filestlavaijrel. 5.0_123lib Add Yariable. ..

Run/Debug Settings @ Source attachment: {None)

Task Repasitary @] Javadoc location: http:|fjava.sun.com/iZsef1,5.0/dacs apif Add Library...

Task Tags .‘?? Mative library location: {Mone)

Walidation .’EE Access rules: (Ma restrictions) - non modifiable Add Class Folder. .

oy jsse.jar - C:\Program Files)Javaljrel,5.0_124)ib
jce.jar - C:\Program Files)Javaljrel.5.0_124)ib
-;u charser.]ar - C:'I,Prugran? Flles'l,Ja\oja'l,]rel .5.0_1.2'|,I|b
| dnsns.jar - C:iProgram Files!Javaljrel,5.0_123liblext
localedata. jar - C:\Program Files|Javaijrel.5.0_124iblext - -
sunjce_provider,jar - C\Program Files)Javaijrel,5.0_124iblext Migrate JAR File...
sunpkes11.jar - CiProgram FilesiJavaljrel . 5.0_12\liblext
B JUnit 4
@ Ok ] [ Cancel
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